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MOLECULAR MODELLING 
 
OPIOIDS 
 
Exercise 24.16  Comparison of SB205588 and SNC80 
 
INTRODUCTION   
In Exercise 15, we showed that tetracyclic structures such as SB205588 (R=Et) were 
structurally related to oxymorphindole (Fig. 1). 
 

 
 
Figure 1 Oxymorphindole and a simplified structure. 
 
SmithKlineBeecham proposed that there was a relationship between SB205588 and another 
delta-selective agent called SNC 80 (Fig. 2). They proposed that SNC 80 contained a basic 
amine and a methoxy-substituted aromatic ring which corresponded to the basic amine and 
phenol present in SB205588 
 
 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
Figure 2 SNC80 and SB205588. 
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They superimposed the structures to see whether the corresponding groups were reasonably 
aligned and in doing so sought to identify a feature in SNC 80, which acted as the address for 
the delta-receptor. By overlaying the structures, the address segment would be positioned in 
a similar region of space as the aromatic ring of SB205588. The conclusion was that the amide 
group in SNC 80 could act as an address segment. 
In this exercise, we will have a go at duplicating this work. 
Note that the original research paper talked about finding an alignment that also aligned the 
pyrrole ring of SB205588 with the other aromatic ring of SNC 80. 
The molecular modeling described led to the proposal that the aromatic ring in SB205588 
could be replaced by an amide group as the address. The following analogue of SB205588 
(Structure XIII) was synthesized to test this theory (Fig. 3). Identify whether you think the 
amide is linked to the correct position of the pyrrole ring. Determine also whether the bond 
connecting the amide group to the pyrrole ring is freely rotatable. 
 
 

 
Figure 3 Structure XIII   
 
 
INSTRUCTIONS 
It is suggested that you attempt the following instructions yourself before following the more 
detailed Procedures that follow. You may find the file entitled Common Operations for 
ChemBio3D/Chem3D a useful guide on how to carry out various operations.  
 
PART A 
*Create the energy-minimised 3D-structures of SB205588 and SNC80 from their ChemDraw 
structures (available in the ChemDraw folder). 
*Try out different overlays of SB205588 with SNC80 by using various pairings. 
*Identify the benefits or drawbacks of each overlay. 
*Identify which overlay seems the best. 
*Carry out any modifications such as single-bond rotation that might improve an overlay. 
PART B 
*Use a suitable overlay to justify why the amide group in the SB205588 was placed where it 
was. 
*Create an energy-minimised 3D structure of the analogue by modifying SB205588. 
*Carry out a conformational analysis by generating conformations where the amide bond is 
rotated. 
*Identify the energy barrier to rotation. 
PART C 
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*Create the energy-minimised structure of the analogue without the methyl substituent on 
the pyrrole ring. 
*Carry out a conformational analysis by generating conformations where the amide bond is 
rotated. 
*Identify the energy barrier to rotation and compare this with the energy barrier when the 
methyl group is present. 
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PROCEDURES 
There are various approaches that you can use to tackle these molecular modelling exercises. 
The following procedures illustrate how you might tackle this particular exercise, but they are 
not meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer and the version of ChemBio3D/Chem3D used. For example, the specific 
conformations obtained from energy minimisation may differ, as may quantitative results 
such as steric energies. 
 
1. Create an energy-minimised 3D-structure for SB205588 
*Open ChemBio3D or ChemDraw. 
*From the File menu, choose Open, then select the ChemDraw file for SB205588 from the 
ChemDraw folder. Click Open. 
*Display the structure as a stick model. 

*Energy minimize  the structure (Fig. 4). A steric energy of 30.74 kcal/mol is displayed in 
the bottom window. 
 

 
Figure 4  Energy-minimised structure of SB205588. 
 
2. Create an energy-minimised 3D structure for SNC80 
 
*Repeat the procedures described above to create a 3D-model of SNC80 (Fig. 5). The steric 
energy is calculated as 42.67 kcal/mol. 
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Figure 5  Energy-minimised structure of SNC80. 
 
3. Copy and paste the structures into a new window 
*Select SNC80 by double clicking on one of the atoms, or lassoing the structure with the Select 

tool . 
*From the Edit menu, choose Copy. 
*From the File menu, choose New to open a new window. 
*From the Edit menu, choose Paste. 
*Repeat these steps to copy and paste SB205588 into the new window 
 
4. Align the structures  
*Select one of the structures by lassoing it or double clicking on one of the atoms. 

*Select the translate  or rotate tool . 
*With the shift key depressed reposition the selected molecule. 
*Repeat these operations to reposition the other molecule such that they are aligned as 
shown in figure 6. 
 
5. Recolour SB205588 

*Choose the Select tool . 
*With the shift key depressed, click on all the carbon atoms in SB205588. 
*Hover the cursor over one of the selected atoms, then right click the mouse to produce a 
menu. 
*Select Color, then Choose color. Select your chosen colour from the colour palette, then click 
on OK. 
*Repeat these procedures to recolour the nitrogen atoms and the oxygen atom. 
 
6. Pair up atoms between the phenol group and the methoxy-substituted aromatic ring.  



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

We are now going to pair up atoms in preparation for the overlay.  Pair up the oxygen atoms 
and two of the aromatic carbons (Fig. 6). 

*Choose the Select tool . 
*With the shift key depressed, click on the two atoms that are to be paired up. 
*From the Structure menu, choose Measurements, then select Display Distance 
Measurement. 
 

 
Figure 6  Pairings set up for the overlay. 
 
 
 
7. Overlay the structures. 
*From the Structure menu, choose Overlay, then click on Minimise. A dialogue box will 
appear.  
*Retain the default values and click Start. 
Two or three successive overlays may be necessary to get a satisfactory overlay. In this 
experiment, the minimisation was carried out at a minimum RMS Error of 0.100, then at a 
minimum RMS Error of 0.05, then finally at a minimum RMS Error of 0.01. A manual 
manipulation was then carried out by selecting one of the structures and manipulating its 
position such that the paired atoms were closer, then a final minimisation was carried out at a 
minimum RMS error of 0.01. This resulted in a good overlay where the atoms were separated 
by only 0.1 Å (Fig. 7). Carrying out the overlay in this way results in a good overlay for the 
aromatic rings, but a poor overlay of the basic nitrogen atoms. Therefore, it is necessary to 
look at alternative methods of carrying out the overlay such that both the aromatic rings and 
the basic nitrogens are reasonably close. 
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Figure 7 Overlay based on the aromatic rings containing phenol or methoxy group 
 
 
6. Overlay the structures based on the amine nitrogen atoms plus the phenol and 
methoxy-substituted aromatic rings. 
*Click on the Undo icon to separate the structures. 
*Include the nitrogen atoms in the pairings (Fig. 8). 
*Repeat the overlay. The overlay minimization was carried out with a minimum RMS error of 
0.1, then 0.05 to give the overlay shown in figure 9. The overlay was slightly better but the 
nitrogen atoms were still 1 Å apart. Moreover, the rings in the address segment are poorly 
aligned. 
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Figure 8  Pairing up atoms prior to the overlay (aromatic rings and basic nitrogen atoms). 
 
 

  
Figure 9 Overlay based on pairing the basic amines and aromatic rings  (variation 0.2-1.0 Å)  
 
7. Overlay the structures based on the amine nitrogen atoms and the centroids of the 
phenol and methoxyphenyl rings. 

*Click on the Undo icon  until the structures are separated. 
*From the Structure menu, select Measurements, then click on Clear. 
*Choose the select tool.  
*With the shift key depressed, click on all the carbon atoms of the phenol ring present in 
SB205588. 
*From the Structure menu, choose Add Centroid. 
*Repeat these procedures to add a centroid to the methoxyphenyl ring of SNC80 (Fig. 10). 
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Figure 10 Addition of centroids to the message aromatic ring of both structures. 
 
*Choose the Bond tool. 
*Create a dummy bond between the centroid and the basic nitrogen atom in SB205588 by 
dragging the mouse from the centroid to the nitrogen. 
*Choose the Select tool. 
With the Shift key depressed, click on the nitrogen atom and the centroid. 
From the Structure menu, choose Measurements, then Display Distance Measurement. 
*Repeat these processes for SNC80. 
 
A dummy bond has been introduced between the centroid and the amine N for three reasons. 
It defines a pharmacophore based on the basic amine and the centre of the aromatic ring and 
allows a measurement of the distance between these centres.  It also allows the centroids to 
be included in the overlay process since centroids on their own are not recognized when 
carrying out overlays. The N-centroid distances for SB205588 and SNC80 are 4.9 Å and 6.1 Å 
respectively (Fig. 11).  

 
Figure 11 Dummy bond between the basic amine and centroid. 
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*From the Structure menu, select Measurements, then click on Clear. 
*Pair up the nitrogen atoms as previously described. 
*Pair up the centroids. 
The structures are now ready for an overlay based on the nitrogen atoms and the centroids of 
the message rings (Fig 12). 
*Carry out the Overlay process as previously described. The resulting overlay has a 0.6 Å 
separation between both the amine nitrogens and the centroids (Fig 13). Importantly, the 
address regions are quite well aligned in this overlay 
 
 

 
Figure 12 Pairing up the amine nitrogen atoms and the aromatic ring centroids. 
 
 

  
 
Figure 13  Overlay based on the amine nitrogen atoms and the aromatic centroids. 
 
8. Overlay based on the basic amines, the centroids of the message aromatic rings and 
the centroids of the address rings. 
The authors of the original article stated that a better overlay was achieved by including the 
centroid of the second aromatic ring on SNC80 and the centroid of the pyrrole ring in 
SB205588 (Fig 14).   
*Add the centroids to the second aromatic ring in SNC80, and the pyrrole ring in SB205588. 
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*Measure the distance between the basic amine and the centroid on the address ring for both 
structures. The distances are fairly similar at 6.0 Å and 6.5 Å (Fig.14). 
*Clear all measurements. 
*Add dummy bonds to define a pharmacophore triangle connecting all three centres. This also 
allows the centroids to be counted in the overlay (Fig. 15). 
 

 
 
Figure 14  Definition of centroids and measurement of the amine-centroid separations. 
 
 

 
Figure 15. Definition of pharmacophore triangles. 
 
*Pair up the basic nitrogens, the message centroids, and the address centroids (Fig. 16). 
*Carry out the overlay (Fig. 17). 
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Figure 16 Matching the nitrogens and the two centroids. 
 
 

   
Figure 17 Resulting overlay (separations 0.6, 0.6 and 0.1 Å) 
 
The message aromatic rings are reasonably well aligned and the basic amines are reasonably 
close (within a bond length). The pyrrole ring of SB205588 is also well aligned with the 
address aromatic ring of SNC80. Moreover, we can now see that the amide group in SNC80 is 
positioned close to the aromatic ring in SB205588. Since the latter acts as the address 
segment in SB205588, it is possible that the amide acts as the address segment in SNC80. 
 
9. Overlay the structures using just the basic nitrogen atoms and the address centroids 
Since the distances between the nitrogen atoms and the address centroids are quite similar, 
another approach to creating an overlay would be to use these centres to get an initial overlay 
that provides the best superposition for these two features. The structure could then be 
modified by manual rotation to get the best overlay for the message rings. 
 

*Click on the Undo icon  until the structures in the previous overlay are separated. 
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*Clear all measurements, then pair up the nitrogen atoms and the address centroids (Fig. 18). 
*Carry out the overlay operation (Fig. 19). 

 
Figure 18  Pairing up the nitrogen atoms and the address centroids. 
 

 
Figure 19 Overlay based on the basic nitrogen atoms and the address centroids. 
 
The overlay is bad for the message rings, with the centroids 3.9 Å apart. The pharmacophore 
triangles are also badly aligned. However, there is a good superposition for the nitrogen 
atoms and the address centroids where the paired centres are separated by only 0.3 Å and 0.2 
Å. The overlay can now be manually modified by selecting one of the N-centroid dummy 
bonds and rotating it to bring the message rings closer together. 

*Choose the Select tool . 
*Select the centroids of the message rings and display the distance measurement between 
them. This will help identify when the rings are brought closer. 



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

*Click on the side of the pharmacophore triangle linking the basic nitrogen to the centroid of 
the address segment (Fig. 20). In this experiment, the pharmacophore that was highlighted 
belonged to SNC-80. 
*Open the Rotation Dial and rotate the dummy bond until the message aromatic rings are 
close to each other (Fig. 21). The separation between the centroids is reduced to 1 Å. 
 

 
 
Figure 20 Choice of dummy bond to rotate prior to rotation. 
 
 

  
Figure 21 Overlay after rotation of the dummy bond. The centroids of the message aromatic 
rings are now separated by 1.0 Å.   
 
The overlay can be further improved by rotating the bond to the methoxyphenyl ring of SNC-
80 (Fig. 22A). However, the dummy bonds to the phenol and the methoxyphenyl rings have to 
be deleted first by using the Eraser tool (Fig. 22B).  
Rotating the bond by -20o brings the rings parallel (Fig. 23). 
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Figure 22 A) Bond to be rotated in SNC-80 is highlighted. B) Removal of dummy bonds to the 
centroids of the phenol and methoxyphenyl rings. 
 

  
 
 
Figure 23 Overlay following rotation of the aromatic ring.  
 
*Remove the centroids and remaining dummy bonds using the eraser tool to get the following 
diagram of the overlay (Fig. 24). 
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Figure 24  Overlay after removing centroids and dummy bonds. 
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PART B 
We will now consider the structure of the SB205588 analogue where the aromatic ring that 
acts as an address has been replaced with an amide group. We will create the structure then 
assess whether the methyl group is acting as a conformational blocker. 
 
1. Identify why the amide group in the SB205588 analogue has been placed where it is.  
Consider again the overlay in figure 24. It should be evident that the amide in SNC 80 is 
situated relatively close to one particular carbon atom of the pyrrole ring in SB205588 – the 
one next to the nitrogen atom. This is the position that is substituted in the analogue 
described. Note, however, that the carbonyl group of the amide group is not coplanar to the 
pyrrole ring in the overlay. In the analogue, it will be coplanar. 
 
2. Create an energy-minimized 3D model of the SB205588 analogue. 
*Copy the structure of SB205588 and paste it into a new window (Fig. 25A). 
*Choose the Eraser tool and click on the two carbon atoms that need to be deleted (Fig. 25B). 
*Choose the Type tool and use it to add the NEt2 group (Fig. 25C). 
*Choose the Double Bond tool and add the double bond (Fig. 25D). 
*Choose the Type tool to replace the =CH2 with =O (Fig. 25E). 
 

   

 
A) SB205588    B    C 
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 D      E 

 
 
Figure 25  Steps involved in building the amide analogue of SB205588. A) SB205588 B) 
deletion of two carbon atoms C) Addition of NEt2 group D) Addition of double bond E) 
Replacing CH2 with O. 
 

*Energy minimize the structure . The resulting structure (Fig. 26) should have a steric 
energy of 53.3 kcal/mol. This is Structure XIII. 
*Save the structure as Structure XIII such that the window is suitably labeled. 
 

 
Figure 26  Analogue of SB205588 containing an amide group instead of an aromatic ring 
 
3. Carry out a conformation analysis on rotation of the amide substituent. 
The methyl group on the pyrrole ring has been included as a conformational blocker to hinder 
rotation of the bond between the pyrrole ring and the amide substituent. We will carry out a 
conformational analysis to identify the size of the energy barrier to bond rotation in the 
presence of the methyl group and compare that with the energy barrier when the methyl 
group is absent. 



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

*Choose the Select tool . 
*Click on the bond between the pyrrole ring and the amide substituent (Fig. 27). 

 
Figure 27  The bond chosen for rotation in the conformational analysis. 
 
*From the File menu, choose Preferences to open a menu (Fig. 28A),  
* Click on the tab for the Dihedral Driver to open another menu (Fig. 28B) 
*Use the slider bar to alter the resolution to 1o. 
*Click on Apply and OK. 
 
 

  
 
  A     B 
Figure 28  A) The Preferences menu B) Dihedral Driver Preferences  
 
*From the Calculations menu, choose Dihedral Driver, then Single Angle Plot. Since the 
resolution is set for 1o rotations, 360 conformations will be generated. The resulting Dihedral 
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Driver Chart (Fig. 29) shows a significant energy hill that has to be crossed when rotating the 
bond. The dihedral angle measured on the x-axis corresponds to the three bonds highlighted 
in figure 30. The energy barrier amounts to 503-52 kcal/mol = 458 kcal/mol. The actual 
energy barrier is likely to be less than this as the conformational analysis carried out here 
does not take into account the possibility of other bond rotations easing the steric clashes in 
the high-energy conformation. Nevertheless, the energy barrier is still likely to be substantial. 
 

 
Figure 29  Dihedral Driver Chart for rotation around the bond highlighted in figure 27. 
 

 
Figure 30  Bonds chosen for dihedral angle measurements given in the dihedral driver chart. 
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PART C 
To assess the influence of the methyl group in creating the energy barrier identified in part B, 
we will now consider what the energy barrier to rotation would be if this methyl group was 
absent. 
 
1. Create the energy-minimised structure of the analogue lacking the methyl 
substituent. 
*Copy and paste the structure of the analogue (Structure XIII) into a new window 

*Select the Erase tool .  
*Click on the carbon atom of the methyl group to erase the whole group. 

*Energy minimise the structure . 
The resulting structure (Fig. 31) has a steric energy of 45.8 kcal/mol.  
 
 

 
Figure 31 Energy-minimised analogue lacking the methyl substituent.  
 
2. Repeat the conformational analysis on the new structure. 
The dihedral driver chart involving rotation round the highlighted bond was carried out on 
the demethylated analogue without minimization (Fig. 32). Rotation was round the bond 
highlighted in figure 33. 
 

 
Figure 32 Dihedral Driver Chart for rotation round the bond specified. 
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Figure 33 The bond being rotated is highlighted in yellow. 
 
The dihedral angle used to define the conformations in the chart was for N(11)-C(12)-C(14)-
O(26), which has been defined in figure 34 for the initial conformation used to create the plot. 
The highlighted bond to oxygen is obscured by the pop up window, which shows that the 
energy-minimised structure has a dihedral angle of 3.3o. This corresponds to the most stable 
conformation on the plot (Fig. 35). 

 
Figure 34 Definition of the dihedral angle N(11)-C(12)-C(14)-O(26). 
 
 

 
Figure 35 Position on the plot corresponding to a dihedral angle of 3o. 
 
*Hover the mouse over the highest peak in the plot to show a pop up window giving the 
dihedral angle and steric energy for the least stable conformation in the plot. 
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The pop up window reveals that the least stable conformation has a dihedral angle of 89o and 
a steric energy of 76.37 kcal/ mol (Fig. 36). 
 

 
Figure 36  Identification of the least stable conformation on the plot. 
 
Therefore, the energy barrier for the unminimised chart is approximately 76-46 = 30 
kcal/mol. This is significantly lower than the energy barrier of 458 kcal/mol that was 
observed when the methyl group was present, demonstrating that the methyl group is acting 
as a conformational blocker.  
 


